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Problem Set #0: Getting to Know UCINET 6 
 

Adapted from original by Peter V. Marsden, Harvard University 
 
This problem set is designed to familiarize you with basic functions for managing network data 
within the UCINET 6 software. UCINET is a suite of programs written by Steve Borgatti, Martin 
Everett, and Linton Freeman. UCINET started out a loosely connected set of DOS routines that 
were contributed by the three authors. Over time, it has grown up to have a Windows interface 
and a growing suite of capabilities. Version 6 is by far the most polished and integrated one so 
far. However, this is not SPSS or Stata. There is no multi-million dollar corporation developing 
this program; the users probably number in the thousands. So it has bugs and inconsistencies that 
are only identified slowly. It also has eccentricities. Most especially, you will notice that 
UCINET tends to create many, many files in the course of doing an analysis. Keeping track of the 
output is a challenge. Thus, this program may have a steeper learning curve than some other 
statistical packages. 
 
The installation CD includes a Word-based User’s Guide and Reference Manual. The program 
places these files in the program’s home folder; they should also appear in the UCINET folder in 
the “Start” menu. I have placed PDF copies of both in ERes. (A paper copy seems a waste, as the 
file has neither table of contents nor an index; you are better off searching the PDF.) The 
program relies heavily on online help for documentation of specific procedures. You may want to 
print your own copy of the user manuals, but they will provide general rather than specific 
instructions as to the use of the software. If you want to have more specific documentation of 
procedures, either (a) locate that procedure in the Index of the Help menu and print the associated 
file or (b) search the Reference Manual PDF 
 
In this problem set, we will work through mechanics like starting up, viewing an existing dataset, 
entering a new dataset, extracting portions of a dataset, and other basic data manipulations. We’ll 
also cover the UCINET routines for egocentric network data. 
 
Because the problem sets serve both as a guide to using UCINET and as a way for me to test your 
knowledge, the problem set texts can be rather long and wordy. To make clear what you need to 
turn in, be sure to always attend to the items in bold and italics. 
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Introduction 
 
Public-use copies of UCINET 6 are available on all lab computers around campus. We have a 
license for 24 copies. If 25 or more people try to use UCINET at once, the system will not allow 
users 25 to infinity to boot up a copy. 
 
To start the program, use the Start menu in Windows to locate and start UCINET 6 – or click on 
the UCINET 6 icon if one has been placed on the desktop. 
 
Here is the basic console: 
 

 
 
 
There are seven top-level menus in UCINET 6: 
 

File is for various file-management activities – altering a default folder, renaming and 
deleting files, and so on. 

 
Data is for entering, generating, and importing/exporting data files from other file 
formats (such as Excel spreadsheets). It also has some basic data transformation 
commands. 

 
Transform contains many more involved transformations of the data. 

 
Tools includes a number of routines for scaling and clustering relational data, forming 
measures of similarity and dissimilarity, graphics, and certain statistical procedures. 

 
Network is a key menu – it contains graph-theoretic routines, routines for identifying 
cohesive subgroups of various kinds, central/peripheral actors, conducting “positional” 
analyses, and many other network-analytic routines. 
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Visualize provides links to “helper” programs that create network visualizations. 
 
Options sets display options. 
 
Help provides help with routines implemented in the other menus.  

 
Below the menu is a tool bar: 
 
  Spreadsheet view DL editor 
 
      View dataset List of previous procedures used 
 

 
 
        Edit text  Launch Netdraw 
 
    Exit      Matrix algebra editor 
 
Spreadsheet view is used to view a dataset in an Excel-like window. This view is used to update 
or change data. When “Spreadsheet view” launches, it opens a blank window. You will need to 
tell UCINET where to look for the file and then which one you wish to open. Try opening the 
“Camp92.##h” file – this is one of the datasets included with UCINET. 
 

• If you are working on a lab computer, you will first need to download the dataset by 
going to the Support Materials section of the class website and download the files under 
the link “All Datasets Included with UCINET 6.” This file is zipped, so unzip it, placing 
the contents either in a folder in “My Documents” on the lab computer or on a folder on a 
Zip cartridge. 

 
• If you are working at home, UCINET installed the default files in a folder called “Data 

Files” within the main folder for UCINET (usually found in the “Program Files” folder). 
 
Go to the File menu in View Spreadsheet and use the Open command. You should be in the 
“Data Files” folder or the folder you created on the lab machine or your personal Zip cartridge. In 
this window you will see several files with a “##h” extension. Files with the extension “##h” are 
UCINET files. However, if you look in the actual folder, you will see that each file also has an 
(evil?) twin with a “##d” extension. The ##d file contains the numeric data; the ##h file contains 
the labels. However, you must have both in order for UCINET to do anything. 
 
“DL Editor” is used to edit data that is described using one of several formats that are included in 
the DL data description language. We will not discuss the DL language in great detail during the 
course, but it can be very useful if you need to convert data from list form (i.e., a list of dyads or 
edges) into a matrix form. The Help menu includes an extensive section on the DL language. 
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“View dataset” shows the data as a text file; it has no editing capability. This view can 
sometimes be useful if you need to transfer a matrix of network data to a word processor or 
another statistical package. “NetDraw” is a graphical package that display network data. We will 
discuss it in greater detail later.  
 
The “Edit text” button opens Notepad, which is the free basic text editor included with Windows. 
The “Matrix algebra editor” is used to execute matrix operations on UCINET datasets. We will 
not use this function during the course. Finally, like Stata and other statistical packages, UCINET 
includes a drop-down menu that lists all commands that were previously executed so that you can 
re-run them without wading through multiple menus. 
 
At the bottom of the main console on the right side is a “file drawer” icon next to a window 
showing a path name. The path name is the default folder that UCINET current looks at. You can 
change this by clicking on the “file drawer” and then navigating through your hard drive’s file 
structure. Changing the default folder for UCINET will change the default for all subprograms 
(like NetDraw, Mage, etc.). 
 
In contrast to a statistical program in which one begins by loading a dataset and then operating on 
it using various procedures, in UCINET one first invokes a procedure and then selects a dataset 
on which to operate. UCINET is a menu-driven program, with lots of submenus. In many of 
these, you must name or rename datasets and output files. The default entry for an input file will 
usually be the last one you worked with, which may or may not be what you want. Take your 
time as you work your way through the options in the menus – though the default settings are 
often fine. 
 
As noted before, UCINET generates and saves a lot of datasets in the course of its operations. 
Usually these are given default names, which may be overwritten with no warning if you repeat a 
procedure; so you must change these defaults if you wish to retain your results for further 
analysis or manipulation. The Options menu has a setting that limits the number of output logs 
retained, but these are not the only logs generated. While working with a public-use copy of the 
software, it may be helpful to have a USB drive (AKA “flash drive” or “keychain drive”) so that 
you can retain copies of your own data files or of key output files generated. 
 
Because UCINET creates so many output files, it is imperative to keep a handwritten or word 
processor-based list of file and output names. I usually have a small lab notebook that I use for 
this purpose. I also create a separate folder for each analysis session. The name of the folder 
usually includes the date and the “master” dataset that I started with. 
 
 
Default Directories 
 
You need to be sure to set the default folder for locating and storing your datasets. By default, 
UCINET datasets are stored in a folder like C:\Program Files\UCINET 6\DataFiles. To change 
the default folder (say to a place where you’ve stored your own data), use the “Change Default 
Folder” command in the File menu, or click on the “file drawer” icon. 
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Saving and printing output 
 
Most UCINET commands generate output, and you can save this to a file. Output will appear on 
the screen, and you can save it using a File/Save as menu within the output screen, or using a 
Save icon appearing in a tool bar at the top of the output screen. You have the option of renaming 
output files in this process. 
 
Similarly, output may be printed – before or after editing – using the File/Print menu or the Print 
icon. Output screens also have the standard cut/copy/paste edit commands. 
 
Be sure to include a copy of your final output in any write-up for problem sets in this class. 
 
Viewing a dataset 
 
As noted before, there are two ways to view data: using the data viewer or the spreadsheet view. 
Try both options for the dataset on relationships among workers in the Bank Wiring room, the 
name of which is “Wiring.” You will need to get this file from the website (see the instructions 
for downloading the UCINET default files above) or use the copy that UCINET installed on your 
machine (see above). You should see six distinct relations among the 14 actors in this dataset, the 
first of which is RDGAM. The first four relations are binary symmetric linkages. RDHLP is an 
asymmetric binary relation, and RDJOB is a valued relation (it gives the number of times one 
participant was observed doing another participant’s job). Note how that in the spreadsheet view 
each relation is given a separate tab at the bottom of the window, just as in Excel. 
 
 
Creating a dataset 
 
For direct data entry within UCINET, you can use the Spreadsheet Viewer. This utility also 
allows you to edit existing datasets. (You can also get to this by clicking the “spreadsheet” icon 
on the toolbar.) 
 
Try this out by selecting five to seven friends you know pretty well. The idea is to analyze the 
network among your friends and you. With whom do you communicate? Who do they 
communicate with? Do you call them, do they call you, or both? Think about the friends you 
nominated. Do they call each other? For instance, does Ken call Sally? Does Sally call Ken? 
Guess if you have to, but note whether you guess or not. We will use this little dataset off and on 
throughout the course. 
 
Now we need to create a mathematical summary of these relationships. Start by creating a matrix 
by hand, using 1s to correspond to people who call one another and 0s for people who do not. Put 
a 1 in a row and column if a friend in that row calls the friend in that column. Put a zero in the 
diagonal. The diagonal is self-communication. For individuals, self-communication is assumed 
(unless you are psychotic) to be irrelevant. Later, we will see instances where self-
communication will be of interest and cannot be assumed. Here is my example: 
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 Karl Jodi David Chris Victor 
Karl 0 1 1 1 1 
Jodi 1 0 1 0 1 
David 1 0 0 0 0 
Chris 1 1 0 0 0 
Victor 1 1 0 0 0 

 
Karl and Jodi (my wife) both call one another (six times a day it seems!). I call my other friends 
David and Chris. I also see Victor Asal (in the Political Science Department) almost as much as 
my wife! However, Chris and David don’t call one another. I met Chris while at Penn and David 
at Harvard; they don’t know one another. Jodi knows David pretty well, but she doesn’t usually 
call Chris. Victor knows Jodi well but has never met my friends from previous universities. 
 
Now enter the numbers into the UCINET spreadsheet and save the results. After the data are 
entered you may create labels in the shaded areas that appear at the head of columns and to the 
left of rows. 
 
If you would prefer to put the labels in first, set the size of the data array by placing a 0 at its 
lower right (the 5,5 cell for my data), and then use the “fill” option (there’s a button for this) to 
put zeros in the rest of the matrix. You will then be able to put labels in the rows and columns, 
and edit the cell entries to install the 1s that correspond to friendship citations. 
 
Save the completed data file. Since we will revisit this dataset, you should probably create a 
separate folder for it on your hard drive or USB disk and maintain a “pristine” copy of the 
original data. Then view the dataset using the data viewer on the toolbar; put the resulting 
output in your write-up. 
 
Now try creating a dataset that corresponds to the graph on page 123 of Wasserman and Faust 
(W&F). This network is a small; it is an illustrative network of friendship citations for six 
schoolchildren. Be sure to include the labels. We will use this dataset repeatedly as well, so be 
sure to create a folder for it. 
 
Use the “view dataset” icon on the toolbar to output the data from your network and the W&F 
children’s network and include this output in your write-up. 
 
 
Exporting a Dataset 
 
Should you wish to open a dataset created in UCINET using some other software program, you 
can use the Data/Export menu to write it in a format that another program can read. I have used 
this option repeatedly to move data into Excel or Stata for other types of analysis. As we shall 
see, sometimes it is easier to use Excel for certain types of counts data, and Stata or SPSS are the 
preferred option for other forms of linear statistics. 
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Try using the export command to move your personal network data from UCINET to Excel. 
Include a printout of your Excel spreadsheet in your write-up. 
 
As a first step, use the “file drawer” icon to change the default folder to the one you created for 
your personal dataset. Now use the Data/Export/Excel command. It will bring up a window like 
this: 
 

 

 
 
The “Input dataset” line may be blank or it may contain (as in this example) the name of the last 
file you were working with. You may choose the dataset by clicking on this icon. The “three 
dots” icon always brings up a navigation box that will help you find a dataset. If you have reset 
your default folder properly, you should be inside your new folder for your personal dataset. 
Choose your dataset and click OK. In my case, the window will then become: 
 

 
 
Click “OK” to execute the export. Then use Excel to verify that the export worked. 
 
Include a printout from Excel of your personal dataset in your write-up. 
 
 
Importing a Dataset 
 
You can enter data into UCINET in various ways. For example, matrices may be entered in 
Excel, Access, FileMaker Pro, or many other database or spreadsheet programs and then 
imported using the Data/Import menu. In most cases, the data must be in tab or comma delimited 
form. UCINET can also directly read Excel files. 
 
Trying using the Data/Import via spreadsheetcommand to import the Excel spreadsheet you 
just exported. Include the UCINET output in your write-up. 
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Manipulating Datasets 
 
UCINET provides a wide variety of utilities for transforming datasets. We’ll try out some of the 
options here. 
 
 
1. Selecting a relation. 
 
When a dataset includes more than one type of tie – as in the case of the “Wiring” data – it will 
often be useful to extract one matrix, since many network methods are capable of dealing with 
only one relation at a time. 
 
Try this out using the Data/Extract menu. You will need to indicate that you are extracting a 
matrix, not a row or a column. Select the first of the six relationship – the one that identifies 
pairs of men who were observed playing games together. Be sure that you Keep rather than 
Delete this matrix. Save it as a new dataset called “Games”, rather than using the UCINET 
default name for the output file. Include a copy of the output in your write-up. 
 
 
2. Removing one or more “nodes” or “vertices”. 
 
It will often be useful to remove one or more nodes from a dataset. Sometimes you may just want 
to see what happens to a structure if one actor is deleted – this is known as examining the 
“vulnerability” of the structure to deletion of an actor. In other cases you may need to remove 
actors for technical reasons. This is often done when one or more actors are “isolates” – actors 
that have no relationships to the others. Some analytic methods (for instance, multi-dimensional 
scaling) assume that all actors are related to each other, at least indirectly. 
 
In the “Games” dataset you have just created, two actors (S2 and I3) are not involved in any 
game-playing relations with others. Remove them from the dataset using the Data/Extract menu; 
this time you will want to delete two rows and two columns: I3 is in row/column 2 while S2 is in 
row/column 13. Save the dataset as “Games1”, so that you retain copies of both “Games” and 
“Games1”. (You can select rows and columns to retain or delete by clicking on the “L” icon to 
the right of the selection box, and selecting items from the list that appears, rather than entering 
the list by hand.) 
 
Use the “view dataset” icon on the toolbar to view your revised dataset. Include this output in 
your write-up. 
 
 
3. Re-ordering rows and columns of a dataset 
 
It will sometimes be helpful to re-order the rows and columns of a dataset. 
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You can do this directly in the Data/Permute menu – here you enter the new order directly from 
the keyboard. You can also do sorts according to an ordering that appears in a separate dataset. 
For example, many analytic routines will produce such orderings, or you can create your own in 
the spreadsheet editor. To re-order a network using a stored ordering, use the Data/Sort menu. 
 
Here, use Data/Permute to move the inspector (I1, in row 1) to the last row and column. You 
will need to reorder rows and columns in the same way, and will enter “2 to 12 1” in the rows 
box. Save the reordered dataset as “Games2”. 
 
Use the “view dataset” icon on the toolbar to view your revised dataset. Include this output in 
your write-up. 
 
 
4. Making an asymmetric dataset into a symmetric one. 
 
Note that not all friendship citations in the W&F matrix were reciprocated. Are all the 
relationships in your personal network reciprocal? Answer this question in your write-up and 
explain how the matrix entries tell you whether the data is symmetric. 
 
It will sometimes be useful to alter a dataset so that all links between pairs of actors are bi-
directional. In other words, in some cases, we collect data where Person A reports that they talk 
to Person B but Person B does not report that they talk to Person A. There is a flow of 
information from A to B, but not from B to A. This is asymmetric communication, exchange, or 
whatever. In many cases we will want to analyze the meaning of B “dissing” A. However, some 
analytic routines require that input data be symmetric, and other times there is a substantive or 
methodological case for “symmetricizing” data. In matrix terms, it requires making the upper and 
lower triangles of the matrix mirror images of one another. 
 
You will need to specify a criterion to use for creating the entries in the new, symmetric network. 
This is the “symmetricizing method.” Choosing the Maximum of the (i,j) and (j,i) entries 
corresponds here to assuming that a friendship exists when either friend/child mentions it. 
Choosing Minimum assumes just the reverse: a friendship is present only when it is mutually 
acknowledged. Choosing Average will treat an unreciprocated citation as a tie intermediate in 
strength between mutual and null citations. 
 
Try Transform/Symmetrize using the Maximum and Minimum option on your personal 
network and the W&F child network, saving the output datasets under a new name each time. 
Include the UCINET output that results in your write-up. 
 
 
5. Transposing a Dataset 
 
It will sometimes be convenient to “transpose” an asymmetric dataset so that rows become 
columns and columns become rows. This can be done in the Data/Transpose menu. Do this using 
the original dataset on the W&F children, noting that the output dataset is the reverse image of 
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the input dataset – columns here are senders rather than receivers of friendship citations. Save the 
transposed dataset with a new name. Include the output in your write-up. 
 
This is a good point at which to look at a feature of certain types of UCINET output which is 
absolutely maddening. Here is a transpose I ran on my personal network: 
 
 
TRANSPOSE 
-------------------------------------------------------------------------------- 
 
Input dataset:        H:\Rockefeller Courses\PAD637\Problem Sets\Problem Set #0\Karl 
Data\KarlExample 
Output dataset:        H:\Rockefeller Courses\PAD637\Problem Sets\Problem Set #0\Karl 
Data\TKarlExample 
 
Matrix 1: 
 
          1 2 3 4 
          K J D C 
          - - - - 
 1 Karl   0 1 1 1 
 2 David  1 0 0 1 
 3 Jodi   1 1 0 0 
 4 Chris  1 0 0 0 
 
Transposed matrix saved as dataset TKarlExample.##h 
 
---------------------------------------- 
Running time: 00:00:01 
Output generated: 07 Aug 03 16:08:04 
Copyright (c) 1999-2000 Analytic Technologies 
 

 
First a formatting aside: I simply cut from the results window and pasted into Word. To 
maintain the look and feel, I retained the Courier font but reduced the size to 9 points. At 9 
points, most output will fit on a letter-sized page that has 1 inch margins. 
 
Now the maddening part. Look at the row headers. UCINET uses an internal numbering system 
for each actor. In UCINET’s thinking, Karl is “1”; David is “2”, Jodi is “3”, and Chris is “4”. 
UCINET also displays the full label for each actor in the network on the row. No problem here. 
 
Now look at the column headers. UCINET displays its internal actor numbers in the first row (or 
two rows, if there are more than 9 but fewer than 99 actors in a network). However, only the first 
letter of the label is provided. For a small dataset with proper names as headers, this may not be 
too confusing. But here is a situation you should try to avoid. For my dissertation research, I 
made the labels for each actor A1, A2, A3, and so forth. When I ran analyses that produced new 
network partitions, I would get very confusing column headers. Here is an example: 
 
Matrix 1: 
 
     1 2 3 4 
     A A A A 
     - - - - 
 1 A1 0 1 1 1 
 2 A3 1 0 0 1 
 3 A4 1 1 0 0 
 4 A2 1 0 0 0 
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Again, the row headers are fine. However, UCINET’s column headers seem to say that column 
two is A2, which is wrong. Column two contains data for actor A3. Whenever a matrix is 
permuted, an actor’s row and column position must be identical. If I move Karl to the row 1 
position, I must also move his data to the column 1 position. The labels seem to say something 
went wrong with UCINET. UCINET’s technical work is fine. The presentation really sucks…I 
mean leaves a lot to be desired. The problem arises because the numbers in the very first row (or 
two rows, for larger datasets) of the output corresponds to UCINET’s internal numbering of the 
actors, not my own. This problem can also occur if you use only numbers to identify your actors. 
 
6. Joining two datasets. 
 
In Item 1 we extracted a matrix from a dataset. Sometimes we will want to do just the reverse, 
putting two datasets together into a larger, multi-relational dataset. 
 
This can be done in the Data/Join menu. Try it out with the W&F children file and its 
transpose. You will first have to select the files to join, and then indicate whether to join them 
along the row, column, or matrix dimension; choose the latter. Give the output file a new 
name. Inspect the joined file by entering the spreadsheet and opening it there; you will see 
that separate files have been created for the original dataset and its transpose. Include the 
output in your write-up. 
 
In other cases you may want to join datasets along the row or column dimensions. 
 
 
Basic Graph-Theoretic Measures 
 
Command menus in UCINET allow you to obtain some basic graph-theoretic measures. I’ll 
review just a few of these. You might try them out on the “Games” dataset or the W&F 
children’s friendship dataset. 
 
In the Tools/Univariate Stats menu you can get a summary of the average relations in rows or 
columns of a data matrix. These are the “matrix marginals” and will prove to be closely related to 
one type of network centrality measure. You need to run the routine separately to get summaries 
of relations sent (usually the rows) and received (usually the columns). 
 
In the Network/Cohesion/Density menu you can calculate the overall density (average tie 
strength) of a network. Later on, you may find it useful to look at subgroup densities by entering 
a partitioning vector, but for now just look at the overall density.  
 
Try at least the two measures discussed here and one other not discussed. Include the 
UCINET output in your write-up. 
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Measures for Egocentric Networks 
 
The Network/Ego Networks menu provides a number of measures of properties of the egocentric 
networks surrounding each actor. Here, certain structural measures are calculated for egocentric 
networks within a complete network. The density submenu for this command provides egocentric 
measures of network size, network density, and so on; see the Help menu for some information 
about each of the measures calculated. The Structural Holes submenu provides other measures 
based on Ron Burt’s book of the same name (Harvard University Press, 1992). 
 
Try the Network/Ego Networks/Egonet basic measures  submenu for the “Games” dataset 
that you extracted earlier in this exercise. The measures of principal interest are Size and 
Density. Run the necessary routines to recover these measures. Include the output in your 
write-up. 
 
Many times, egocentric measures are calculated not from complete network data as is done here, 
but instead from data collected in social surveys containing name generator/interpreter 
instruments that measure only the network surrounding a survey respondent. Such data are not 
readily managed within UCINET. Instead, analysts often use standard statistical packages like 
SPSS or Stata to calculate egocentric measures, and then associate them with other data about the 
survey respondent.  Steve Borgatti, creator/maintainer of UCINET is now developing a new 
package, EGONET, that will offer many new features. However, as a of August 2006 EGONET 
is still in the “alpha” version stage of development. 
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